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				Optimize PDF Files – tips on pdf optimization to compress file size & optimizing pdf files – Acrobat 8 review
		
			October 26, 2018September 25, 2006 by Website Optimization 		

		
	Summary: We review Acrobat 8 Professional (pre-release) and PDF Enhancer 3.1 for optimizing PDF files. The new Acrobat features faster operations, smaller PDFs, a new interface, and the ability to combine different types of files into one PDF. Learn how to use PDF optimization tools to remove redundancies, subset and outline fonts, and compress text and images for faster downloads and higher user satisfaction.


			
			
		
			PDF optimization is often overlooked when creating PDF files for the Web. While PDFs have become quite popular on the Web, many PDFs used in web sites are designed for high quality print output and are not optimized for the Web. Even PDFs designed for Web use can have a wait problem, weighed down with excess fonts, change histories, and unoptimized images and forms. Optimizing PDF files for the Web can significantly shrink their size and boost display speed, saving bandwidth and user frustration.





In this article we’ll give you tips and tools to optimize PDFs for minimum file size while still maintaining accessibility and search engine visibility. We review Adobe’s PDF Optimizer in Acrobat 8 Professional (pre-release) and Apago’s PDF Enhancer 3.1.

What Is a PDF?

Portable Document Format (PDF) is the defacto file format for presenting device-independent documents on and off the Web. PDFs are an efficient way to accurately describe simple to intricate documents for screen or print output. A PDF document is a collection of objects with structural information in a self-contained series of bytes. PDF is a page description language, like PostScript but simplified with restricted functionality (no programming like PostScript) to be more lightweight. PDFs use the following compression algorithms to reduce file size:

	LZW (Lempel-Ziv-Welch, see Minimize Bit Depth) and FLATE (ZIP, in PDF 1.2) for lossless compression of text and images
	JPEG and JPEG2000 (PDF version 1.5) for lossy (or lossless for JPEG2000) compression of color and gray scale images
	CCITT (the facsimile standard, Group 3 or 4), run-length, and JBIG2 compression (PDF version 1.4) of monochrome images


It is in how well you use these compression techniques, how efficiently the data is described (including image resolution) and the complexity of the document (read number of fonts, forms, images, and multimedia) that ultimately determines how large your resulting PDF file will be.

Creating Small PDFs

The main factors in creating small PDFs are image resolution, image type (bitmap or vector), the number of fonts used and how they are embedded, PDF version, and the level of compression. In general the higher the PDF version number, the smaller the file. Acrobat 5 (PDF version 1.4) added JBIG2 compression, which is superior to the CCITT or Zip algorithms when compressing scanned monochromatic copy (see Table 1). JBIG2 (Joint Bilevel Image Experts Group) encodes compressed monochrome (1 bit per pixel) image data from 20:1 to 50:1 for pages full of text. Like other dictionary-based algorithms (LZW, ZIP) JBIG2 creates a table of unique symbols and when a subsequent symbol matches one in the table, it substitutes a token pointing to the table index. JBIG2 also compresses the entire table.

Acrobat 6 (PDF version 1.5) added the ability to compress the entire file (Clean Up Settings dialog). However, since over 90% of Acrobat users have version 5.0 or greater, using PDF 1.4 is a safer alternative. Acrobat will usually display (with a warning) a more recent PDF version, but new compression schemes will spawn an error when opened in older versions of Acrobat.




Table 1: Acrobat Version Information


	Acrobat Version	Year Introduced	PDF Version	Major Features Added
	3.0	1996	1.2	Added interactions, movies/sounds, forms, CJK (Chinese, Japanese, Korean), web (hyperlinks, URLs, etc.), linearization for fast page display
	4.0	1999	1.3	Added structure, digital signatures, file embedding, JavaScript, RTL (Right to Left), color separations, Postscript Level 3 additions, uses opaque imaging model
	5.0	2001	1.4	Added JBIG2 compression, transparent imaging model, tagged PDF files (for standardized extraction of objects)
	6.0	2003	1.5	Added Compress entire file, XFA Forms (XML)
	7.0	2005	1.6	Added improved PDF Optimizer Interface, Path smoothing, Chopped image repair, Image enhancement (despeckle, etc.), can embed OpenType fonts
	8.0	2006	1.7	Improved PDF Optimizer Interface again, broke out “Discard User Data” into one pane, flatten form fields, combine and optimize files. Some improvement in areas of 3D, advanced commenting features, and security. Note defaults to saving in Acrobat 1.6 format.




To create the smallest possible PDFs for the Web minimize the number of fonts, bitmapped images, and substitute vector based-graphics instead. Minimize the number and complexity of forms in your PDF document and flatten form fields, and avoid the use of multimedia.

There are different methods to create PDFs, including outputting to PostScript and Distilling, GDI/Printing (Webopedia Definition of Graphic Device Interface), one-click “Direct to PDF,” and dynamically on the server-side. However you create a PDF, the techniques and tools listed below can help you enhance and optimize your PDFs for the Web.

Avoid Refried Graphics

For graphics that must be inserted as bitmaps, prepare them for maximum compressibility and minimum dimensions. Use the best quality images that you can at the output resolution of the PDF. Inserting compressed JPEGs into PDFs and Distilling them may recompress JPEGs, which can create noticeable artifacts. Use black and white images and text instead of color images to allow the use of the newer JBIG2 standard that excels in monochromatic compression. Be sure to turn off thumbnails when saving PDFs for the Web.

Use Vector Graphics

Use vector-based graphics wherever possible for images that would normally be made into GIFs. Vector images scale perfectly, look marvelous, and their mathematical formulas usually take up less space than bitmapped graphics that describe every pixel (although there are some cases where bitmap graphics are actually smaller than vector graphics). You can also compress vector image data using ZIP compression, which is built into the PDF format. Acrobat Reader version 5 and 6 also support the SVG standard.

Minimize Fonts

How you use fonts, especially in smaller PDFs, can have a significant impact on file size. Minimize the number of fonts you use in your documents to minimize their impact on file size. Each additional fully embedded font can easily take 40K in file size, which is why most authors create “subsetted” fonts that only include the glyphs actually used.

Flatten Fat Forms

Acrobat forms can take up a lot of space in your PDFs. New in Acrobat 8 Pro you can flatten form fields in the Advanced -> PDF Optimizer -> Discard Objects dialog. Flattening forms makes form fields unusable and form data is merged with the page. You can also use PDF Enhancer from Apago to reduce forms by 50% by removing information present in the file but never actually used. You can also combine a refried PDF with the old form pages to create a hybrid PDF in Acrobat (see “Refried PDF” section below).




Figure 1: Flatten form fields to save space




Dueling Color Spaces

RGB (Red Green Blue) is an additive coloring system where the addition of each color moves the mixed color towards white. CMYK (Cyan Magenta Yellow Black) is a subtractive system where adding color to each part moves the mixed result towards black.

RGB is used in computer screens and televisions. Every system that emits light uses RGB. CMYK is used in reflective systems where the color is set by the reflection of light on a surface. Printing systems are the prime example.

It is important to use the right system for your color-based project. The most important factor is the gamut of each system. Gamut is the range of color each system can generate. RGB is very good at providing bright reds, blues, and greens. CMYK can’t do this. Thus converting from RGB to CMYK can give unpredictable results. Not many applications do this well, although Adobe PhotoShop and PDF Enhancer color maps perfectly (1,2).

(1) http://www.adobe.com/products/adobemag/archive/pdfs/98auhtbf.pdf RGB versus CMYK gamuts, from Adobe. RGB almost covers the CYMK gamut, according to this technical document from Adobe. Converting from CMYK to RGB is pretty safe, but color changes do occur.

(2)Email from Leonard Rosenthol of Apago. Feb. 10, 2005.



Use the RGB versus CMYK Color Space

For web-only PDFs if you have a choice, use the RGB color space for your PDFs versus the CMYK color space. RBG has one less data channel than CMYK, so files are that much smaller in size. Also, Microsoft applications all think in RGB, even when importing CMYK images.

Convert to Grayscale

If color is not required, you can convert your PDF to grayscale. In Acrobat 8 select Advanced -> Print Production -> Convert Colors menu. Under Document Colors select “Device Gray,” and under Destination Space choose “Gray Gamma 1.8” or 2.2. A test on a color print ad saved 54% when converting to grayscale (save as).

Optimizing Existing PDFs

In many cases you won’t have access to the original document, just the resulting PDF file. Many PDFs we’ve seen are not fully optimized for the Web, using conservative settings more appropriate to high-resolution printers. For computer monitors viewing web-based PDFs, you don’t need high resolution images and exact reproduction of font faces, you just want to convey your information in an efficient way. Using the techniques outlined below, you can shrink your PDFs, while still maintaining the textual data for search engines, and reasonable quality for print output. Some webmasters offer two versions of their PDFs, once for fast web display, and one for printing.

Save As…

Once you’re done making changes to your PDF document choose File -> Save As and overwrite your existing PDF file (see Figure 2). By default, save as removes changes that are appended to PDFs by the Save command, linearizes the file for fast web viewing, and removes unused objects.




Figure 2: Save As to save space



The result is a compact, linearized PDF that displays the first page (or an arbitrary page) quickly, while the rest of the file downloads in the background. Although linearized PDFs are slightly larger, they also increase perceived speed. Note that optimizing a signed document will invalidate its signature. More »

Optimize PDF Files > PDF Optimizer > PDF Optimizer 2 > Combine Files > Optimization Tools
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							Lou Ambrosini						


													
																	
										February 3, 2006 at 12:03 pm									
															

												


									

				
					When using Adobe Acrobat 6.0 and selecting the PDF optimizer option, I noticed it alters the page sizes slightly. Is there a way to set it so that it maintains the original page size?

Thanks,

Lou

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										February 3, 2006 at 1:56 pm									
															

												


									

				
					Lou,

I don’t know the answer to that one. I use Acrobat 7 Pro now. Perhaps one of our readers can help Lou out here that uses Acrobat 6?

Acrobat’s “PDF Optimizer” encapsulates Distiller into one compound dialog box, it has lots of options. You’ve got to watch the compatibility level to make sure that most of your audience can read the file, and discard the things you don’t need.

– Andy

Reply				

			
			
	
			
				
										
						
							Hans Olav Nilsen						


													
																	
										February 12, 2006 at 4:27 pm									
															

												


									

				
					Hello

I have thousands of pdf’s that have font-objects. With-definitions…

In most documents the fonts are not used in layout manner.

Can your software remove unused fonts, in  ‘batch’ mode ?

Best regards Hans Olav Nilsen

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										February 13, 2006 at 10:48 am									
															

												


									

				
					Hans,

Hi, I don’t make the software, I just write about it (sounds a bit like GE). You can subset embedded fonts, what this does is only keep the glyphs that are used (a,b,c) and discards the ones that are not referenced in the document.

– Andy

Reply				

			
			
	
			
				
										
						
							Gordon						


													
																	
										March 8, 2006 at 12:19 am									
															

												


									

				
					Andy,

Do you or any of your readers know of a way to stop Acrobat7 (Pro) from prompting you to save a file before it converts it?

I am converting MS Word files that have links to data in excel.  Acrobat7 can now convert multiple files but each file requires a confirmation which negates the benefit still requiring a user to sit and confirm the process each file!

Thanks in advance,

Gordon

Reply				

			
			
	
			
				
										
						
							MAHADEVAN						


													
																	
										March 13, 2006 at 3:42 am									
															

												


									

				
					Hello,

I have an one question.

I have saved one PDF file. File size contains 1mb.

I just want to copy the contents of the file and paste it on to the Outlook (e-mail), with same clarity and file size.

Please advise how I can make it. It will be ideal if you can send  the process by step by step.

Thanks,

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										March 13, 2006 at 10:06 am									
															

												


									

				
					Mahadevan,

Hi, the easiest way to do this is just send the PDF as an attachment. For Outlook you goto File -> New -> Mail Message menu (Ctrl+N) to create a new message. Then click on the paper clip icon or Insert -> File menu and double click on the PDF file you want to send. Fill out the to/subject/body of your email and hit the SEND button.

For Eudora similar procedure, Message -> New Message (or Ctrl+N), then Message -> Attach File (or Ctrl+H).

If you want to just send the contents or text of a PDF there are a number of options. You can use Acrobat Professional and Save As -> Text (or HTML), and this saves just the text within the file. I tried this on a 1070KB file and it saved the text as 117K, but it won’t look nearly as pretty as the PDF. Then you could use the above procedure to attach that .txt file, or cut and paste the text directly into the body of your email. You can also select all when you are in the PDF, but this didn’t work as well for me.

Hope this helps,

– Andy

Reply				

			
			
	
			
				
										
						
							Anastasia						


													
																	
										March 16, 2006 at 12:14 pm									
															

												


									

				
					Hi,

I have been given a 94 page pdf file (scanner output of notes) which is 150MB. Any ideas on how to reduce the file size to a normal size?

I use Acrobat 6.0.

Thank you very much.

Anastasia

Reply				

			
			
	
			
				
										
						
							Francesco						


													
																	
										April 21, 2006 at 2:45 am									
															

												


									

				
					Anastasia,

this software is able to transform your images in text (using OCR):

CVisiontech PDF Compressor

It costs a lot and does not work if your notes are hand written.

May be another solution is to convert your images in a lighter format (lower resolution/gif black and white).

Reply				

			
			
	
			
				
										
						
							Crispin						


													
																	
										April 22, 2006 at 11:30 pm									
															

												


									

				
					Hi,

Do you have any thoughts on the level of security/security options to apply to PDFs that are to be posted on the web?  Ideally we’d like to prevent people copying and pasting from our docs (although printing is fine) – is that good practice these days?

If so, do you have any thoughts on how to best accomplish this with Acrobat Pro 7?  We don’t seem to be able to save as PDF 1.4 (for v5 Readers and up) and also have security.  We can do either one, but not both.  Darn.

Any thoughts on pros/cons/good practice in this security and compatibility area would be welcome.

Kind regards,

Crispin

Reply				

			
			
	
			
				
										
						
							rocky						


													
																	
										May 26, 2006 at 7:00 am									
															

												


									

				
					Is there any way to attach a file (any file) in pdf

through javascripting?

please help me out

regards

rocky

Reply				

			
			
	
			
				
										
						
							Adam						


													
																	
										June 3, 2006 at 11:41 am									
															

												


									

				
					I would like to know what the biggest (size of the file) able to be converted from word to PDF professional 7.0?

Reply				

			
			
	
			
				
										
						
							sjb						


													
																	
										June 7, 2006 at 7:48 pm									
															

												


									

				
					Anastasia,

You can do a “Save As” in Acrobat. Save the image as a jpg file.  Then, import the jpg images into a word document.  Then, re-distill the word document you just created in “smallest file” instead of “Standard” in your print settings.  The resulting pdf will retain its clarity, but will be reduced in size 20-30%

Scansoft (www.scansoft.com) makes a pdf software that can convert scanned documents back to editable text (Word, Wordperfect) for about $99.00.  I used it on a 350 page document. The formatting didn’t stay very well, but the OCR was incredibly accurate.  Good Luck!

Reply				

			
			
	
			
				
										
						
							Kathy						


													
																	
										June 9, 2006 at 5:22 pm									
															

												


									

				
					I have made a pdf file using a scanner. The file size is great 150kb, but when I go to print it out, it prints at like 200mg or something outrageous. How do I get the printer size to match the file size?

Reply				

			
			
	
			
				
										
						
							Alfa						


													
																	
										June 18, 2006 at 8:22 am									
															

												


									

				
					I have a couple of GB’s of pdf’s, which I need to reduce in file size & optimize for web viewing. What is the easiest way to do this?

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										June 18, 2006 at 8:51 am									
															

												


									

				
					Alfa,

Get the latest version of Acrobat Professional and use the Advanced – PDF Optimizer as well as Advanced Menu – Batch Processing. You can also use third-party tools that make it even easier.

– Andy

Reply				

			
			
	
			
				
										
						
							Eric						


													
																	
										June 27, 2006 at 8:48 pm									
															

												


									

				
					I scan about 10-15 pages of invoices at a time into a PDF document, using my HP OfficeJet 6110 all-in-one.  The problem is that the resulting PDF file is typically between 20-30 MB, which is too large to email to many people.  I scan using 200 dpi resolution, which seems to work fine (100 dpi is too poor of quality).

Any ideas for how to reduce these file sizes?  Thanks.

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										June 28, 2006 at 9:45 am									
															

												


									

				
					Eric/all,

Getting lots of questions about scanned PDF file sizes. Whevever possible work from the original Word etc. file and save as a PDF. In my experiments with Acrobat 7 Pro just now I found that a one-page document saved as a PDF was 25.1K. Saved as a TIFF and converted to a PDF (effectively scanning the document) it is nearly 10 times larger! (240K). Adding searchable text (document -> recognize text using ocr, then advanced -> accessibility -> add tags to document) bumps it up to 246K.

Of course, you don’t always have the option of saving your PDFs from the originals, you may just have printouts. Scanned PDFs can become quite large since they are images of the page(s), so with Acrobat Pro 7 you can optimize the PDF using Advanced -> PDF Optimizer -> Scanned Pages and check the “Optimize compression of page regions…” checkbox. When I tried this on the above 246K PDF Acrobat crunched the PDF back down to 34.6K.

CVISION Technologies makes software that reportedly compresses beyond what Acrobat can do.

Hope this helps,

– Andy

Reply				

			
			
	
			
				
										
						
							Nicholas						


													
																	
										June 28, 2006 at 6:45 pm									
															

												


									

				
					I saw your review. Do you know if it’s possible to “Reduce File Size” of batch PDF files?

Thanks.

Reply				

			
			
	
			
				
										
						
							Greg						


													
																	
										June 29, 2006 at 12:09 pm									
															

												


									

				
					Pdf file size increases when I use file reduce or pdf optimizer. Any thoughts?

Reply				

			
			
	
			
				
										
						
							Cara						


													
																	
										June 30, 2006 at 10:06 am									
															

												


									

				
					Hey I was hoping you could help me out.

I’ve been making pdf’s with grayscale images in them, and they don’t print in grayscale. They print properly in Photoshop CS2, and they look the same in Acrobat 7 Pro, but then when I print from Acrobat, it prints in a blue tinge. Why is it doing this? This is for a book I’m making and it needs to print properly. Please help!

Reply				

			
			
	
			
				
										
						
							Lisa						


													
																	
										July 7, 2006 at 10:52 am									
															

												


									

				
					I use version 7.0 Standard and I want to know how to remove colour from an already scanned document.  Is it possible to do in Acrobat?  Can I convert a file with colour into a Black and White version?

Reply				

			
			
	
			
				
										
						
							Jorio						


													
																	
										July 20, 2006 at 7:35 pm									
															

												


									

				
					ABO, Lossless compression engine, can reduce any file by 8x. You can request copy by calling Di Jorio

@ 408.230.1218

Reply				

			
			
	
			
				
										
						
							James						


													
																	
										July 25, 2006 at 4:01 am									
															

												


									

				
					Andy,

Thank you for your useful guide.  I am curious about the different colour model inputs and outputs.  You mention that Microsoft applications ‘see’ in RGB, and therefore output in RGB also.

I am using Microsoft Publisher 2003 to create a newsletter (consisting of text and colour photographs) that will be output to PDF.  In the ‘Advanced Print Settings’ dialog there is an option to output RGB, CMYK and GRAYSCALE.

Utilising the opensource PDFcreator, it is also possible to define the output colour model.  I have been experimenting with different input/output colour model options, and find that setting Publisher to output CMYK and setting PDFcreator to also output CMYK produces a 1.9mb file, whereas the RGB—>RGB equivalent produces a 5.5mb file.

Can you explain the discrepancy?  Is there perhaps some additional compression applied when using the CMYK colour model?

Thank you,

James

Reply				

			
			
	
			
				
										
						
							Mark						


													
																	
										August 15, 2006 at 6:04 pm									
															

												


									

				
					i use version 6.0 . .  i just scanned a document and  its size was pretty large (9.5 mb) for only half a page scanned that was saved as  aa PDF…is that normal size for one scanned document..?? Can i  shrink that file…and how..??

Mark

Reply				

			
			
	
			
				
										
						
							Christine						


													
																	
										August 30, 2006 at 5:17 pm									
															

												


									

				
					When distilling a word document to PDF, new text is added to PDF that does not exist in the word document.  The same results were obtained when this document was distilled using Adobe 6.0, Adobe 7.0 and Pdf995.  Why are characters are being added to PDF?

When the document is opened and a particular page is printed, the information in a cell that is an embedded excel spreadsheet changes and prints out incorrectly (with Parenthesis).  However, if the cell is highlighted (clicked on) and then printed, the page is printed properly – with no added paren’s.

Reply				

			
			
	
			
				
										
						
							mahesh						


													
																	
										September 11, 2006 at 4:45 am									
															

												


									

				
					hi friends,

I want to attach the file (word object) in the pdf. How can i attach the file. and if i click that file object it should open.How can i do it. Please reply me.

Regards,

Mahesh

Reply				

			
			
	
			
				
										
						
							lexi						


													
																	
										September 14, 2006 at 4:04 pm									
															

												


									

				
					Is it possible to save a color PDF file as a grayscale .PDF file?

Lexi

Reply				

			
			
	
			
				
										
						
							bob						


													
																	
										September 15, 2006 at 2:22 pm									
															

												


									

				
					Hi,

I have Adobe Acro Pro 7 but have never used it before. I have many documents (books and jpeg files)which need scanning and compressing but I don’t know how to compress them to be as absolutely small as possible. However I have a 696 page pdf file (book) which someone (I don’t know who) has managed to compress into 3.96Mb, which astounds me and is exactly the sort of thing I need to do. Could someone advise me the best way to go about this? I would be VERY grateful.

regards,

bob

Reply				

			
			
	
			
				
										
						
							Edward						


													
																	
										September 20, 2006 at 4:05 pm									
															

												


									

				
					Want to reduce PDF file size that has over 100 hyperlinks to our website. PDF will be viewed online and will be downloaded by our students – it is the download that concerns me right now.

I’m using Adobe Acrobat Pro 7.  I am making a PDF of our newsletter with links to our website for ordering products.  Hyperlinks were created in Adobe Indesign and used it to covert to PDF (via smallest file size option). Adobe Acrobat Pro 7 will be used to add Bookmarks and other features.  AAP 7 file optimizer stats seem to indicate that each hyperlink contributes about 305KB to total PDF size. For 100 hyperlinks this will become 30MB and since some of our customers are still on dial up at 56KB modem this would add over an hour to the download time.

The hyperlinks use as Properties … Invisible Rectangle; None as Highlight Style.  Is there a way to create Hyperlinks that would be less KB per link?

PDF is compatible with version 5 and more recent. Would making it compatible with version 6 and more recent reduce overall file size?

The newsletter is 43 pages and has a graphic banner grayscale at the top of each page that will be optimized. However graphics even un-optimized are 1MB which is minimal in comparison to the projected 30MB of hyperlinks.

Thanks for any advice so that I don’t have to re-invent the wheel by my own experimentation. Edward

Reply				

			
			
	
			
				
										
						
							Annette Culley						


													
																	
										September 22, 2006 at 10:21 am									
															

												


									

				
					Does anyone know how I make the black text only come out in the black separation in a CMYK pdf file from Publisher? At the moment the text comes out in all four colours.

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										September 25, 2006 at 10:25 am									
															

												


									

				
					All,

Just published a new version of this article reviewing Acrobat 8 Professional (pre-release) and PDF Enhancer 3.1 from Apago. The new Acrobat has a streamlined, redesigned interface, faster operations (especially Distiller), creates smaller PDF files, and can combine different types of files into one PDF or a “packaged” PDF. I show how to do all this in this expanded tutorial.

Mahesh asked about how to attach a Word file to a PDF, with Acrobat 8 Pro you can do this now. Use the Combine Files menu to group different types of files together into one PDF “package.”

– Andy

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										September 25, 2006 at 10:34 am									
															

												


									

				
					All,

We’ve got a number of questions about reducing PDF file sizes and colors. One thing I noticed that helps is to downsample the resolution of images, color in particular. In Acrobat 7/8 Pro goto Advanced -> PDF Optimizer in the image settings panel choose bicubic downsampling and retain existing compression (to avoid recompressing your JPEGs) and lower the image resolution to 150 or 72 dpi. This had a dramatic effect on PDFs I tested on the Web. One went from 14MB to under 1MB and looked nearly the same.

Hope this helps.

– Andy

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										September 29, 2006 at 8:06 am									
															

												


									

				
					A few people have asked about converting color PDFs into grayscale. Also there were a couple questions about optimizing large scanned PDFs. I updated the article with a section on converting to grayscale and downsampling images, and CVISION makes a product that is good with optimizing scanned PDFs.

I also asked Adobe about these two issues for more details, here are their replies, first for converting to grayscale:

“There are a couple of options, depending on the scenario.

If they use the Create PDF from Scanner or Document>Scan to PDF, they will get the Acrobat Scan dialog. Under the Document section of this dialog, there is an optimization slider that lets you pick between small size or high quality. There is an options button here that brings up an Optimization Options dialog. They can choose:

– Automatic: Aggressive or Pick Custom Settings.

Under Custom Settings, there are two choices:

– Color/Grayscale (pick JPEG)

– Monochrome (pick JBIG2)

If the document has already been scanned, they can open the file and pick Advanced>PDF Optimizer. They should then pick the Image settings section. Note there are a lot of options here. If the scan is a heavily text based document, too much compression may render it unreadable on screen or make it more difficult to OCR later. Make the file compatible with Acrobat 6.0 or later, and don’t downsample below 150 dpi.

The Convert Colors option in the Advanced > Print Production list of tools can convert PDF files to grayscale. If a user needs to make this change to several files at a time, we suggest using preflight with a color conversion rule saved into a preflight profile – that way, the user can automate the conversion of many files.”

2. How to best compress a scanned PDF into a smaller file?

“Compressing a PDF file can be done using Optimizer to control resolution downsampling and compression settings.”

Hope this helps.

Reply				

			
			
	
			
				
										
						
							Charlotte						


													
																	
										October 18, 2006 at 9:47 am									
															

												


									

				
					Does Acrobat 8.0 also supports PDF version 1.4?

Because FDA gives specifications for submitting documents in PDF. They say: ‘ Use PDF Version 1.4. PDF version 1.4 is for use with Adobe Acrobat 5.0 or higher. (It should be noted that Acrobat 6 and 7 use pdfa 1.4.) No additional software should be needed to read and navigate the PDF files.’

What can I use to be compliant?

Thanks, Charlotte

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										October 18, 2006 at 10:24 am									
															

												


									

				
					Charlotte,

Yes Acrobat 8 supports PDF versions all the way back to 1.3 actually. Use the PDF Optimizer and choose the version you want in “make compatible with” menu. Choose Acrobat 5 or later. See Figure 4 on the next page.

I’m not sure how to do this on a Save As, but the PDF Optimizer lets you choose version compatibility with this pull-down menu.

– Andy

Reply				

			
			
	
			
				
										
						
							Neil						


													
																	
										October 18, 2006 at 12:09 pm									
															

												


									

				
					We produce hi resolution pdfs with crop marks, bleed, colour bars and page information for use by the printer of our magazines. Some of them can be 250 pages or more.

Is there a way to get distiller/acrobat to recompress the hi-res pdfs as a batch and crop them in size to remove the excess page information? This is so we can quickly re-publish each magazine for free on the web without going through the entire process again with different settings.

Many thanks, Neil.

Reply				

			
			
	
			
				
										
						
							Oliver						


													
																	
										October 25, 2006 at 9:12 am									
															

												


									

				
					Hi,

i have two almost identical pdf files. When I try to save them as html or xml in Acrobat Prof. 6.0 one of the files is accessible (I can select and copy the text) and the other one just gets saved as an image (obviously I can’t select & copy the text out of it). Does anyone have a clue why this happens and how I can change it to save both pdfs with accessible text?

Thanx a lot in advance!

Reply				

			
			
	
			
				
										
						
							Dwight Kelly						


													
																	
										October 26, 2006 at 1:59 pm									
															

												


									

				
					For PDF optimizations, including compressing scanned documents, and converting color PDFs into grayscale check out Apago’s PDF Enhancer.

http://apago.co/prod_home.php?prod_id=37

Reply				

			
			
	
			
				
										
						
							Ambika						


													
																	
										November 3, 2006 at 7:12 am									
															

												


									

				
					Hai.,

Can I add text in ADOBE 7.0, not editing the text but adding a new line to an existing document?

Regards

Ambika

Reply				

			
			
	
			
				
										
						
							Rene						


													
																	
										November 18, 2006 at 8:27 pm									
															

												


									

				
					To Eric:  I do a lot of scanning of grayscale images (documents) with or without text and I save them as searchable PDF files.  I tried several products including Acrobat, ReadIris, & Abbyy Fine Reader.  I find that  Abbyy (8.0 pro) will create or optimize and existing PDF file into the smallest searchable PDF.  For example, if I scanned a series of images with Acrobat with a final file size of say 150 MB, Abby would be able to reduce the size to about 30MB, and ReadIris to about 50 MB; and that is without toying around with the resolution, jpeg quality settings, etc…

Reply				

			
			
	
			
				
										
						
							koko						


													
																	
										November 19, 2006 at 6:29 pm									
															

												


									

				
					How to solve Converting Web Page to PDF error?

Reply				

			
			
	
			
				
										
						
							Beth						


													
																	
										December 1, 2006 at 11:05 am									
															

												


									

				
					Is there anyway to reduce PDF printing quality resolution after created in Distiller in order to avoid people downloading it, printing it and selling with no copyrights? All I do now is add a password security limiting the printing to 150 DPI but I wonder if there is any other way.

Thank you! Beth

Reply				

			
			
	
			
				
										
						
							Arif						


													
																	
										December 6, 2006 at 10:48 pm									
															

												


									

				
					Why at the time of printing does the PDF file size become large. I mean if I print just 135K file, it become 10MB. How to reduce it ?

Reply				

			
			
	
			
				
										
						
							Joe						


													
																	
										December 11, 2006 at 10:59 pm									
															

												


									

				
					Don’t understand why Adobe moved adaptive compression (aka “scanned pages”) from PDF Optimizer to File->Scan dialog. In Acrobat 7.0 it was possible to perform adaptive compression on existing PDF files – how they could be optimized now in Acrobat 8.0?

Reply				

			
			
	
			
				
										
						
							P.Siva Reddy						


													
																	
										December 13, 2006 at 10:33 am									
															

												


									

				
					I have Acrobat 6 version but recently I have a problems that some of the PDF files are not printed properly. The letters are unclear and it is difficult to read the printed document. I am using Dot Matrix Printer.

Could you please kindly guide me what do I have to do, for getting printouts clearly.

Reply				

			
			
	
			
				
										
						
							Nate						


													
																	
										December 20, 2006 at 3:21 pm									
															

												


									

				
					Hey Andy,

I saw the section on converting to Grayscale. I’m assuming that’s a feature only available in Acrobat 8 Pro?

Any ideas on how to do this in Acrobat 7 Pro?

Reply				

			
			
	
			
				
										
						
							Nate						


													
																	
										December 20, 2006 at 3:44 pm									
															

												


									

				
					Never mind.

Under Acrobat Pro 7, you can convert the color space by going to Tools > Print Production > Convert Colors…

Another questions I have for you, Andy, is what is the difference between Gray Gamma 1.8 and Gray Gamma 2.2?

Reply				

			
			
	
			
				
										
						
							Kim						


													
																	
										December 22, 2006 at 11:16 am									
															

												


									

				
					In Acrobat 8 – I am not able to select and save a portion of the pdf to bmp format like you could in 7. Any thoughts on this?

Reply				

			
			
	
			
				
										
						
							Larry DuBois						


													
																	
										December 26, 2006 at 7:38 pm									
															

												


									

				
					I do hope you can help me.  I have a lot of mad customers at me!

Sometimes, when I attach a PDF document to an email, my customer can’t open it.  It seems that the common complaint is that the attachment opens as a jumbled up mess of characters.  I read that the cause of this is that some ISP’s misinterpret the attachment as a text file.  I heard that if I were to Zip the document, that would solve the problem.  But, that’s more work for the customer.  I’d rather not do that.

Please help!

Thanks!

Larry

Reply				

			
			
	
			
				
										
						
							Jonathan Lewis						


													
																	
										January 20, 2007 at 10:26 pm									
															

												


									

				
					I just saw Beth’s request for a way to control distribution of copyright material. Check Adobe Pro version 8. It seems to imply that it has provision for some sort of limit on distribution. I haven’t got a copy or tried this. Some distributors of copyright PDF material (such as The Australian Standards Association) limit reproduction of their material by incorporating a date expiry feature so that you can print material for a limited period after downloading, but not subsequently.

Reply				

			
			
	
			
				
										
						
							Susan						


													
																	
										February 1, 2007 at 12:25 pm									
															

												


									

				
					We publish a weekly newspaper and pdf pages to send to the printer. Then we batch process those pdfs and put a link on our website to be downloaded by subscribers.

On those pdfs, the photos are terrible. Very out of focus, soft.

Is there a way that we can keep the crispness of  the original photos so the pdfs that are downloaded from the web, are better?

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										February 5, 2007 at 12:28 pm									
															

												


									

				
					Susan,

Yes, the key I’ve found when creating PDFs for the Web is to start with the highest quality originals that you can. When I create a PowerPoint presentation for example, I use maximum quality JPEGs for example. When you save to PDF it optimizes the JPEGs according to your settings in Acrobat (or Distiller). Medium works well, although sometimes you can get away with low quality. Problem I’ve found is that when you start with an optimized JPEG in your original, and then optimize in Acrobat, you get artifacts from re-optimizing the optimized JPEG. If you start with a max-quality JPEG you avoid this problem.

Of course, you could start with TIFFs but this would make for large sized original files.

Hope this helps,

– Andy

Reply				

			
			
	
			
				
										
						
							mike						


													
																	
										February 6, 2007 at 9:00 pm									
															

												


									

				
					How do I get hyperlinks to work in a Word converted PDF doc without writing out the entire URL, i.e. http:// etc.

Thanks!

Mike

Reply				

			
			
	
			
				
										
						
							Dilip Amritphale						


													
																	
										February 15, 2007 at 11:24 am									
															

												


									

				
					Sir:

I am a research worker. I have published an article in the Classroom section of the Resonance (Indian Science Academy, Bangalore,India), an education science journal. The article is available on the web site of the journal as a PDF file (11.1 MB). I want to distribute it’s copies as email attachment to the teaching community and students. Although, I might send it as Gmail attachment, because of its relatively large size it does not get delivered to many who use yahoo or rediff mail ids. The Resonance people could not help much. I tried to use Winzip, but the size reduction ratio was zero. I have Adobe Acrobat version 5 only. Kindly guide.

Dilip Amritphale

Vikram University, Ujjain, India

Reply				

			
			
	
			
				
										
						
							ACMA						


													
																	
										March 16, 2007 at 10:46 am									
															

												


									

				
					Hi,

I have some .pdf files which are scanned.  The problem is, I need to edit them and cannot do so.  Are you aware of any OCR software that will take scanned .pdfs and convert them to and editable format?

Thanks in advance for your help.

Reply				

			
			
	
			
				
										
						
							Ahsan Khan						


													
																	
										April 7, 2007 at 6:14 am									
															

												


									

				
					My acrobat 8 professional start and close within 1 minute. Please help me out of this problem..

Reply				

			
			
	
			
				
										
						
							Alyssa						


													
																	
										April 12, 2007 at 12:08 pm									
															

												


									

				
					Hello,

I work at a law office and have to e-file documents to the district court.  Every time I scan in pages to be attached to Word documents, they become way to large; a 9 page scan can become 7.15MB and the court only accepts 4MB or less.  So I always end up extracting pages and sending several attachments.  This is very time consuming and a pain for the court and other lawyers. The scanned pages are plain text, black and white.  I have noticed other offices do not have to do this; they send their multi-page docs as one attachment.  I am using Adobe 6.0 and have very basic knowledge of pdf.

I would appreciate your help!!

Reply				

			
			
	
			
				
										
						
							Tracy						


													
																	
										April 18, 2007 at 12:46 pm									
															

												


									

				
					I have large pdf files for high quality print work. I want to be able to (simply) reduce the size of the files for web use. The Reduce File Size command under file in Acrobat 7 works fine, but would like to batch this somehow since I have hundreds to do each month. Any suggestions?

Reply				

			
			
	
			
				
										
						
							JC						


													
																	
										April 23, 2007 at 5:55 pm									
															

												


									

				
					I’ve created a pdf that I would like to be able to email to customers, however, the smallest I can get my file size down to is 2MB.  Any suggestions?  This particular form has approximately 1000 blanks.  It also needs to remain accessible to users with only Reader.

Thanks!

Reply				

			
			
	
			
				
										
						
							website optimization						


													
																	
										April 24, 2007 at 10:51 am									
															

												


									

				
					Ayssa,

Hi, you asked about optimizing scanned PDFs. Scanned PDFs can become quite large as you’ve experienced because the PDF is composed of images, unless you use OCR.

Recommend you get the latest acrobat pro version and go to the “optimize scanned pdf” panel:

PDF Optimizer

and downsample your resolution and optimize to smallest setting. Also using a product like CVision’s CVista PDF Compressor is a good product for compressing scanned PDFs.

Hope this helps

Reply				

			
			
	
			
				
										
						
							Charlotte						


													
																	
										May 4, 2007 at 6:11 am									
															

												


									

				
					Hi,

I would like to know if it’s possible to create a paper trail string of intradocument links.

We have some large documents, some like to review them electronic, others on paper.

For the electronic reviewers there is no problem, they can easily use the links and bookmarks.

Paper reviewers can use the TOC instead of bookmarks, but for links there is no trail on paper.

Does adobe has a tool to create a paper trail of the links inside a documents?

thanks,

Charlotte

Reply				

			
			
	
			
				
										
						
							Nan						


													
																	
										May 29, 2007 at 7:42 am									
															

												


									

				
					I have Acrobat 5.0 version. I could not optimize the size of the larger pdf files. Eg: If I have a file of 6 MB I wish to reduce it to 3.5 to 4 MB.

What should I do? Kindly guide me.

Reply				

			
			
	
			
				
										
						
							Tishcon						


													
																	
										June 29, 2007 at 9:18 am									
															

												


									

				
					I am working as an intern and have been assigned to the task of compressing pdfs; the purpose being to save my company memory.

However, they have given me thousands of files and have only shown me how to do them one at a time! Is there any way to have the computer compress multiple pdfs for me?

This is a serious situation.

Reply				

			
			
	
			
				
										
						
							Mitin Bindra						


													
																	
										August 13, 2007 at 4:28 am									
															

												


									

				
					Hi,

I would like to know if it is possible to find out programmatically whether an existing pdf file is optimized or not at the time of its creation.

Please let me know if someone has any info on the same.

Mitin

Reply				

			
			
	
			
				
										
						
							Rich Waggoner						


													
																	
										August 17, 2007 at 2:36 pm									
															

												


									

				
					When selecting multiple PDF files, right clicking and selecting Combine Supported Files in Acrobat…, Acrobat sometimes starts minimized.  Any idea why this might happen?

Reply				

			
			
	
			
				
										
						
							Anna						


													
																	
										August 27, 2007 at 3:44 pm									
															

												


									

				
					Adobe Acrobat 8 prompts me to save a file before it even scans. Is there a way around this? I just want it to scan first and save later instead of the other way around.

Thanks!

Reply				

			
			
	
			
				
										
						
							Kirra						


													
																	
										September 20, 2007 at 12:09 am									
															

												


									

				
					I currently have adobe reader 6.0 and am needing to scan color brochures with pictures, as they need to be very clear and at a high resolution they come out very large Eg.1-5MB, because I need to email these is there a way I can minimize these considerably.Much appreciated Kirra.

Reply				

			
			
	
			
				
										
						
							Gerry						


													
																	
										October 5, 2007 at 10:47 am									
															

												


									

				
					Hello,

I’m just an old guy who really knows very, very little about computers.  I just want to send some color pictures I put into Microsoft publisher (that is the only place I am fairly familiar with having successfully produced some newsletters for my spouses’ day care class).  I want to send the pics to my brother but my E-mail server won’t send because the file (at least the msg reads – could not send because the its size exceeded the server’s limit).  What can I do to reduce the size and keep all of the color?  Please bear in mind that much of the computer language I read above is way,way, way over my head.

Thanks a million in advance if you can help me.

Gerry

Reply				

			
			
	
			
				
										
						
							Terry Smythe						


													
																	
										November 1, 2007 at 9:39 pm									
															

												


									

				
					For my association, I wish to scan its official journals back to 1964 into PDF format, for both web display and eventual DVD distribution.    Approximately 500+ issues, ~45 pages each.   I’m not prepared to guillotine off the spines, as my source is my personal unbroken 39 years of these journals.

I’m have WinXPHome, 2.6 Ghz, 965 gigs of hard disk space, 3 gigs memory, an HP 4670 “See-Thru” scanner, PSP9, Photoshop CS2, and Acrobat 8 Pro.

I’m trying to develop an optimal approach to arrive at good quality PDF’s for web display, better quality PDF’s for eventual free DVD distribution to our members.

For my initial experiment, see a current 68 page issue in a 7.5 meg PDF file, OCR, optimized, at:

…

Is there an on-line tutorial available somewhere for an application of this magnitude?

Your thoughts?

Regards,

Terry Smythe

Winnipeg, Canada

smythe@shaw.ca

Reply				

			
			
	
			
				
										
						
							tstap						


													
																	
										November 29, 2007 at 10:30 am									
															

												


									

				
					I work for a Printing Company in a Prepress Support Group. We are responsible for testing new software.

I have been testing PDF Optimizer in Acrobat 8 and have ran into an issue.

When I take a 1.7 PDF and use PDF optimizer to make it a 1.6 or 1.5  the image that I am testing becomes corrupt.

If I take a 1.7 PDF and use PDF optimizer to make a 1.4 or a 1.3 the image is ok.

The image that I am using an Orange Text Box with a drop shadow around it. With the text box I am using text that has a drop shadow as well with no knockout and the text is duplicated again with Knockout being applied.

The text has become spread and the drop shadow now looks corrupt in the 1.6 and 1.5 PDF.

I just do not understand why it would ok in a 1.4 and a 1.3 PDF but not a 1.5 or a 1.6.

If the file has not been optimized and I work it through the workflow as 1.3,.1.4,1.5,1.6,1.7 they are all ok as is.

The problem only occurs if the file has been optimized from a 1.7.

Any ideas or since of direction will be greatly appreciated.

Thanks,

Tim S.

Reply				

			
			
	
			
				
										
						
							fadz						


													
																	
										May 6, 2008 at 10:03 pm									
															

												


									

				
					Hi,

I have problem viewing pdf file of lower version using Acrobat Reader 8.0. It appears blank. The pdf files are in version 6.0. What should I do?

Thanks.

Reply				

			
			
	
			
				
										
						
							You						


													
																	
										June 16, 2008 at 8:54 am									
															

												


									

				
					Hi,

I’ve created an optimization profile for a specific find of PDF. I’ve located the .”optimize” file on my mac in order to give it to a friend.

What would be the path of location of those “.optimize” file on windows, of they are compatible…

Thanks!

Reply				

			
			
	
			
				
										
						
							mal						


													
																	
										August 8, 2008 at 11:03 pm									
															

												


									

				
					How do you make 34 pdf files into one file? (34 pages for a book)

Reply				

			
			
	
			
				
										
						
							debby						


													
																	
										September 4, 2008 at 11:31 am									
															

												


									

				
					How do I unembed fonts in a PDF document I received from a designer? I have more than Adobe Reader…I am able to edit but I don’t have the fonts the designer used.

Reply				

			
			
	
			
				
										
						
							Joshua						


													
																	
										October 9, 2008 at 5:31 pm									
															

												


									

				
					I have the same question as above please. I would like to know how to give the optimize setting to someone who needs to reduce files, but does not want to go step by step… Please help with saved setting location. I have look many places.

Reply				

			
			
	
			
				
										
						
							Website Optimization						


													
																	
										October 18, 2008 at 5:21 pm									
															

												


									

				
					Joshua,

To reduce the file size of a PDF first get Acrobat Pro from Adobe.com, the latest version you can. Then go to the File menu -> Reduce File Size… That usually does a pretty good job of shrinking PDFs. This is the easiest method.

The second level of PDF optimization would be under the Advanced menu -> PDF Optimizer…, which we describe in this article. For scanned/faxed PDFs especially using the Scanned Page -> Optimize Compression … checkbox. Adjust quality as necessary.

The third ninja-like level of PDF optimization is to use Acrobat Distiller under the Advanced menu. You can adjust many more settings and really get into the inner workings of the tool by setting up custom optimization settings/files and reusing them. You can also “refry” PDFs by saving as a postscript file (print as postscript), then distilling, and mixing and repeat. This can often produce the smallest files, but you tend to lose some of the nice features which make PDFs useful (links etc.).

There are other tools that you can use to shrink PDFs, see http://www.planetpdf.com for a list of many of them. For industrial strength PDF optimization see http://www.cvisiontech.com .

Hope this helps,

– Andy

Reply				

			
			
	
			
				
										
						
							anonymous						


													
																	
										November 12, 2008 at 5:57 pm									
															

												


									

				
					For Gerry regarding sending photos

I still think it is a good idea to send your photos loose using your email attachment feature, rather than putting them in a publisher document where it will grow to an unmanageable file size very easily.  Before you attach the photos you want to send, save each one in a new file as jpeg images.  Most email can handle photos of 20-30 kb size with no loss of color.  You can also make a nice Publisher Document, print it out on photo paper, and mail it to your family!  They can then put the page in their album!

Reply				

			
			
	
			
				
										
						
							Armando JAIMES						


													
																	
										March 22, 2009 at 2:53 pm									
															

												


									

				
					I have hundreds of PDF text files with hand written notes and circled highlights that I need to copy and paste to MS Word.

Is there a way to copy and paste without the handwritten notes and characters being transferred to word. When I paste to word these handwritten notes totally “disorganize” the document and cause a tremendous amount of time to correct.

I appreciate any help.

Thanks

Reply				

			
			
	
			
				
										
						
							Abhishek Thakur						


													
																	
										March 23, 2009 at 5:15 am									
															

												


									

				
					I was compressing the image, but still the size is more than 1MB. 90 percent of file size is due to image, and I don’t want to compromise with quality of image. Please tell me the way to reduce the image size in pdf.

Reply				

			
			
	
			
				
										
						
							Lou Ambrosini						


													
																	
										April 8, 2009 at 10:22 am									
															

												


									

				
					When using Adobe Acrobat 7.09 and selecting the PDF optimizer option, I noticed it alters the page sizes slightly. Is there a way to set it so that it maintains the original page size?

Thanks,

Lou

Reply				

			
			
	
			
				
										
						
							Lou Ambrosini						


													
																	
										April 17, 2009 at 9:20 am									
															

												


									

				
					When using PDF optimizer in acrobat 7.0 Pro, we noticed that it blurs the image. Is there a setting to change to avoid this?

Thanks,

Lou

Reply				

			
			
	
			
				
										
						
							Andy King						


													
																	
										April 28, 2009 at 1:16 pm									
															

												


									

				
					Lou,

Yes, you can control the compression level in Acrobat Pro. The lower the quality, the ‘blurrier’ it will appear as the JPEG algorithm does its block-level magic. Bump up the quality setting in the images dialog.

Reply				

			
			
	
			
				
										
						
							Mark						


													
																	
										May 8, 2009 at 12:35 am									
															

												


									

				
					Hey how do you optimize a XML form?

I made a PDF in lifecycle designer and when i look at the file it is 369kb. I need it to be way smaller like 30kb.

How can I make it smaller? Acrobat says that it cant be optimized because it is an XML form.

Any help appreciated!

Mark.

Reply				

			
			
	
			
				
										
						
							Bhumi						


													
																	
										June 4, 2009 at 4:43 pm									
															

												


									

				
					What’s the largest pdf file size that should be used on a web page. I have a file that’s 4.2 MB and need to know how much smaller I should make it.

Thanks!

Reply				

			
			
	
			
				
										
						
							sam						


													
																	
										September 10, 2009 at 9:26 pm									
															

												


									

				
					converted a powerpoint doc to pdf then when trying to reduce file size in acrobat a box saying trouble processing images comes up?

Can anyone help with this

Cheers

Reply				

			
			
	
			
				
										
						
							Shaheen skt						


													
																	
										September 17, 2009 at 5:06 am									
															

												


									

				
					hello,

After the conversion into a pdf file, pdf file have more weight than a JPEG or COREL file. How i can make it less or compress it.

Thanks in advance.

Bye.

Reply				

			
			
	
			
				
										
						
							Avinash Maharajh						


													
																	
										October 1, 2009 at 9:58 am									
															

												


									

				
					Please advise me on the procedure to compress a document.  After scanning my qualifications,  it properties are 5.7 mgs.  How do I compress it.  I have acrobat reader andand Gimp software which I recently downloaded.

Please help me

Avinash

Reply				

			
			
	
			
				
										
						
							Debbie Groesch						


													
																	
										October 6, 2009 at 8:06 pm									
															

												


									

				
					I want to design a newsletter in InDesign, save as a PDF or JPG attach to an email and have it display in the email. Is that possible? Or do I need to design it using DreamWeaver and go at it like a web site?

Reply				

			
			
	
			
				
										
						
							Randy						


													
																	
										October 19, 2009 at 1:09 pm									
															

												


									

				
					Hi, I work in a law firm and we use Adobe Acrobat 7.0 Standard.  Whenever I scan a large document, the file is much too large to email.  How would I compress the scanned document so that it is smaller?  There’s no PDF Optimizer under Advanced in my version.  Thanks.

Reply				

			
			
	
			
				
										
						
							Lucas						


													
																	
										October 27, 2009 at 5:38 am									
															

												


									

				
					Great page. Thorough and well-organized. My question was actually sort of the opposite to what you have here. I wanted to know if there is a way to optimize a pdf for presenting on a laptop/projector. I noticed that heavily optimized, very small pdf’s often take a bit longer to bring up on screen because their compressed graphics require more complex algorithms to translate them into images. If you know of any way to make it faster and easier for the computer to navigate through a pdf at the expense of maybe file size, that would be really helpful.

Reply				

			
			
	
			
				
										
						
							Sheri						


													
																	
										December 18, 2009 at 4:44 pm									
															

												


									

				
					Is there a difference between printing to PDF (using the print menu) or converting to PDF (using the Acrobat tab)?  I had to email a PDF recently and first I printed it to PDF and was told it was blurry.  I then converted it to PDF and it seemed fine.  Also, the size of the files differed between the 2 options.  Can you please explain?  Thanks.

Reply				

			
			
	
			
				
										
						
							Fayyaz A Pirzado						


													
																	
										April 14, 2010 at 3:57 am									
															

												


									

				
					Dear Sir/ Madam,

Good article on optimize PDF files.

Please let me know, when I click on command: “Optimize Scanned PDF” whether it process whole PDF document or to single (current) page.

Thanks and regards

Reply				

			
			
	
			
				
										
						
							Romeo Valera						


													
																	
										April 21, 2010 at 11:31 pm									
															

												


									

				
					Could you tell me the maximum pages that Acrobat can print? it’s can print million pages or not?

Reply				
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